
Troubleshooting FTE Reports
Part Two 



The Ohio Department of Education and Workforce funds development of EMIS 
training materials as part of the EMIS Alliance grant. There is an expectation that 
ITCs will utilize these materials in training provided to your districts. That said, there 
are restrictions on use of the EMIS Alliance materials as follows: Materials 
developed as part of the EMIS Alliance program must be provided at no cost to your 
training participants. If you utilize the EMIS Alliance training materials – in whole or 
in part – you must not charge participants a fee to attend the class where the 
materials are used. Likewise, you may not use the materials or any portion thereof 
in any event where a fee is charged to attend. Exceptions must be approved in 
writing by the Ohio Department of Education and Workforce in advance of 
scheduling/promoting any event which may violate these restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for 
exception to the restrictions noted above, should be directed to Melissa Hennon 
[Melissa.Hennon@education.ohio.gov].
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Outline

• Accessing and Preparing Data Collector FTE Reports 

• Reviewing FTE Summary Reports

• Understanding FTE Daily Summary Reports

• Reviewing Your Student Attending Situations and How FTE 
Reports Align with Payments 
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FTE Reports 
• Traditional, JVSDs, and ESCs 

• Beginning of Year Student collection 
• Midyear Student collection 
• End of Year Student collection 

• Community schools and STEM schools
• SOES Beginning of Year Student collection 
• SOES End of Year Student collection 

• All LEAs should submit data through the Student Cross 
Reference(SCR) Collection when the above Student collections are 
processed

• Collections must be processed by DEW for reports to be generated

• FTE Reports use data from the Calendar collections and can also use 
data from the Staff and Course collections
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Accessing and Preparing Data 
Collector FTE Reports 
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Level 2 Reports 
FTE Reports are available in the Level 2 Reports link 
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Generate and Open Level 2 Reports
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Select “Show Reports”

Add a filter to see 
only FTE Reports 



FTE Level 2 Reports 

• (FTES-001) FTE Total by Fund Pattern

• (FTES-002) FTE Total by Student and Fund Pattern

• (FTES-003) FTE Total by Student 

• (FTES-004) FTE Summary of Students with Adjustments 

• (FTES-005) FTE Daily Summary Report – Students District is Educating

• (FTES-006) FTE Daily Summary Report – Students Initially Funded at 
District

• (FTES-007) FTE Daily Summary Report – Transfers
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Your LEA may not receive all
reports listed on this slide 
based on your student 
enrollment situations



Open the FTE Summary Reports
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We are going to review the FTE 
Summary Reports and Daily Summary 
Reports in the upcoming slides

Your LEA may not receive all
reports listed on this slide 
based on your student 
enrollment situations



Reviewing the FTE Summary 
Reports 

10



FTE Total by Fund Pattern (FTES-001) 

Summary by fund pattern with summed original and summed 
adjusted FTEs (not by Inclusion Code)
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FTE Total by Student and Fund Pattern (FTES-002)

Summary by student and fund pattern with summed original 
and summed adjusted FTEs
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FTE Total by Student (FTES-003) 

Summary by student with summed original and summed 
adjusted FTEs (regardless of FTE Fund Pattern Code)
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FTE Summary of Students with Adjustments (FTES-004) 

Summary by student with adjustments with summed original 
and summed adjusted FTEs including the difference

14



Quick Check
• Are you reviewing the FTE 

Summary Reports often?

• Have you tried saving the reports 
to compare to an updated set of 
reports?

• Are you sharing these reports with 
others in your district? 

FTE Summary Reports can be 
used to provide a high-level 
view of student FTE data as 
well as multiple student level 
views. The reports can aid in 
data comparisons based on 
fund patterns, student totals, 
and student adjustments. 
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Understanding the FTE Daily 
Summary Reports 
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FTE Daily Summary Reports
• Contain student FTEs calculated from EMIS data that was processed at ten 

specific times

• Should be reviewed often to identify fluctuations in the number of FTEs 
being generated from specific submissions

• Contain result codes that are not an indication of an error but rather 
identify student education/funding situations

• Contain FTE totals separated by unique combinations of 
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• Special Education Category Code 
• English Learner Category 
• Gifted Identified Code

• Result Code
• Grade Span Code 
• Economic Disadvantagement Flag



Open the FTE Daily Summary Reports
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LEAs will have up to three FTE Daily Summary Reports 



FTE Daily Summary Reports, cont’d

• (FTES-005) FTE Daily Summary Report - Students District is 
Educating
• Contains FTE totals for students the LEA receiving the report is educating 

• (FTES-006) FTE Daily Summary Report - Students Initially Funded 
at District
• Contains FTE totals for students the LEA receiving the report is initially 

funded

• (FTES-007) FTE Daily Summary Report – Transfers
• Contains FTEs by student situation whose funding is transferred in and 

out from the LEA receiving the report
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FTE Run Dates
All three Daily Summary Reports contain the same 10 Run Date columns

• Most recent FTEs are to the left and prior FTEs are to the right

• Run columns can contain zeros at the beginning of a collection 

• Thirty-day averages can sometimes populate incorrectly while more data is 
processed
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FTE Run Dates, cont’d
Look for fluctuations in the FTE values as these could affect payments

21

1. Select the blank cells below the 
FTE values and then select AutoSum 
from the Formulas tab to help 
identify fluctuations

2. The most recent 
data processing 
caused a significant 
drop in FTEs



Error Severity Codes

Error Severity looks at the Thirty Day Average value and 
compares it to the value from the Latest Run to draw attention 
to differences that may be of concern

• The Fatal (F) Error Severity Code indicates a drop from the Thirty 
Day Average value to zero

• Critical (C) indicates a decrease of 10% or more (but not to zero) in 
the Latest Run 

• Warning (W) indicates a decrease of 5% to 10% but not to zero or 
an increase of 20% or more
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Error Severity Codes, cont’d
This example contains a Critical Error Severity Code due to a 
decrease in FTE between the latest run and the thirty-day average

• Remember that the thirty-day averages can be incorrect at the 
beginning of a collection until enough data has been submitted 
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Critical (C) indicates a decrease of 10% or 
more (but not to zero) in the Latest Run 



FTES-005 Students District is Educating

• Includes FTEs for students the LEA is educating regardless if 
the district is initially funded or if the funding will transfer to 
another LEA

• Result Code is FT0100 – Students LEA is educating
• This is the only result code on the FTES-005 Report

• Can appear for any LEA type 
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FTES-006 Students Initially Funded at District
• Includes FTEs of students for which the LEA is initially funded

• Generated for traditional districts, JVSDs, Community 
Schools, and STEM Districts 

• Contains up to seven different Result Codes indicating the LEA 
is initially funded and breaks down transfer information by 
student situation
• Each row on the FTE Detail Report will count in only one result code

• JVSDs, Community Schools, and STEM Districts receive only Result 
Code FT0110 on their report

• Displays FTEs as initially funded, positive amounts
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FTES-006 Initially Funded Result Codes

• FT0110 – Initially funded, no transfer

• FT0111 – Preschool students initially funded, transferred 
to the ESC

• FT0112 - Open Enrolled Preschool Students Initially 
Funded at the LEA and Funds Transferred to Another 
District

• FT0113 - Preschool Students Initially Funded at the LEA 
Transferred to a CBDD 
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FTES-006 Initially Funded Result Codes
• FT0114 - Initially Funded at the LEA Transferred to a JVSD

• Used for Contract Career Tech transfers from the sending district 
to the JVSD

• FT0116 - Initially Funded at the LEA Transferred to Another 
District
• Used for special education cooperative students and contract 

career-tech students 

• FT0119 – JVSD/Compact 20% counted in sending district’s 
enrolled ADM
• Appear on sending LEA’s FTE Detail with inclusion code = PART
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FTES-007 Transfers 

• Contains FTEs that will either transfer in or out from the LEA 
receiving the report 

• Displays FTEs that transfer in as positive amounts and FTEs 
that transfer out as negative amounts

• Can be generated for any LEA type 

• Includes FTEs for students who are
• in preschool open enrollment situations

• in specific non-open enrollment situations

• preschool students attending an ESC
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FTES-007 Transfers Result Codes

• FT0150 – Preschool open enrolled in, initially funded 
elsewhere and funding transferred to educating LEA (positive 
amount)

• FT0160 – Preschool open enrolled out, initially funded then 
funding is transferred to the educating LEA (negative amount)

• FT0170 – Non open enrolled in, initially funded elsewhere then 
funding is transferred to educating LEA (positive amount)

• FT0180 – Non open enrolled out, initially funded then funding 
is transferred to the educating LEA (negative amount)
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FTES-007 Transfers Result Codes, cont’d

• FT0210 – ESC Preschool student received from the resident 
district or a non-open enrolled district that is not the resident 
district; funding is transferred to the ESC from the district 
(positive amount)

• FT0220 – Preschool students sent to an ESC from the resident 
district or from a non-open enrolled district that is not the 
resident district; funding is transferred from the district to the 
ESC (negative amount)
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Quick Check
• Are you checking the Daily 

Summary Reports often to avoid any 
negative impacts on FTE funding?

• Do the numbers of FTE generated 
for the various attending situations 
align with your population of 
students? 

• Are you sharing these reports with 
others in your district? 

FTE Daily Summary Reports 
are helpful to identify 
fluctuations in FTEs that could 
affect funding. They can also 
be used to follow the flow of 
FTE funding based on student 
situations.
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Reviewing Your Student Data 
While  Aligning FTE Reports 

with Payments 
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FTE Reports Level 2 Open, Closed, Archived 

• Level 2 FTE reports in a closed collection contain the data that 
was last processed for that collection 
• Can be used to provide a historical view of data as of the close of that 

collection

• Level 2 FTE reports in an open collection contain the most 
recently processed data 
• Should be used to verify current data in preparation for data to be 

pulled for a payment and in preparation for the close of the collection 

• Archived reports are generated when data is pulled for payments
• Can be used to align data with payments
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Important 
• Payments issued early in the fiscal year can use prior year 

data to generate the payment 
• Archived EMIS reports aligned with a specific payment will not 

align with that payment when prior year data is used

• Payment reports and archived EMIS reports sometimes do 
not match perfectly due to 
• Data being pulled for payment and EMIS reports being archived on 

different dates 

• Rounding from six decimal places in EMIS reports to two decimal 
places on payment reports
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Accessing Archived FTE Reports
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Select the Archive Tab to access Archived FTE Reports 

Add a date in the filter to 
narrow results; use a date just 
prior to the data pull date

Leave Collection Request filter 
set to “All” to receive both FTE 
and CTE FTE Reports 



Archive Reports 
FTE and CTE FTE Reports are captured in the Archive when data is pulled for payment

• Typically, data is pulled two Mondays prior to payment

• Home > Finance & Funding > School Payment Reports, “State Foundation Payment Dates by Fiscal Year”
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January #2 payment 
data was pulled January 9th, 
while the January #2 payment 
date was January 19th

CTE Reports -  JVSDs and Traditional 
districts use the “TRAD” report and 
Community Schools use the “CS” 



Archived FTE Reports that Align with Payments 
• In this series of slides, we will demonstrate how reports from the 

Archive Tab align with payments for various LEA types
• (FTED-001) FTE Detail Report (Current year data including preschool) 

• (FTES-008) Enrolled ADM FTE Summary (Current year and three prior, 
no preschool) 

• (FTES-009) FTE Subgroup Summary – Non-Transfers (Current year data, 
no preschool) 

• (FTES-010) FTE Subgroup Summary – Transfers (Current year data, 
no preschool) 

• (CTEA-000) CTE FTE Detail (Current year CTE data) 

• This is an effective way to get to know your data and to verify 
students are being properly FTE funded
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Payment Reports 
https://reports.education.ohio.gov/finance/foundation-payment-report
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1. Select LEA type, Fiscal Year and “Go”   

3. Select your LEA

2. Select Payment Date  - for this demonstration we will use 
January #2 for traditional districts and ESCs, and January for 
JVSDs, Community schools, and STEM districts

4. We will match Archived EMIS 
report data to some of the 
reports in the dropdown menu. 

https://reports.education.ohio.gov/finance/foundation-payment-report


Payment Reports Aligned with EMIS Reports 

• Traditional Districts, Community/STEM Schools, JVSDs
• Detailed School Funding Payment Report, SFPR (K-23) Current Year Data

• Base Cost (K-23) Prior 3 Years Data 

• Other Adjustments (PS-23) Current Year Data

• Traditional Districts and ESCs 
• Preschool Special Education (PS) Current Year Data

• Traditional Districts 
• Educational Service Center Deduction (PS) Current Year Data

• This is not a complete list of payment reports that contain EMIS data

• We will begin with the Detailed SFPR 
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Enrolled ADM and Special Education ADM 
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Use the “Archived FTE Detail to Detailed 
SFPR Workbook”, to view the students 
who make up Enrolled ADM and Special 
Education ADM 



What is Enrolled ADM?
• FTEs of students that are adjusted, based on attending situations, 

and is used in determining Base Cost 

• The current year’s Enrolled ADM will be demonstrated in two ways
• Archived (FTED-001) FTE Detail Report contains individual students that can 

be filtered to determine the current year Enrolled ADM

• Current and prior years Enrolled ADM has been added to the Archived 
(FTES-008) Enrolled ADM FTE Summary Report
• *NEW* Column H - TOTAL ENRL ADM FTE

• In the next series of slides, we will filter and sum student FTEs on the 
Archived (FTED-001) FTE Detail Report and add them to the FY24 
Archived FTE Detail to Detailed SFPR Workbook to identify the 
Enrolled ADM and Special Education ADM 
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Enrolled ADM on Detailed SFPR – Traditional District 
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Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code and 
Inclusion Code, then sum the Adjusted FTE and enter it (all decimals) into the appropriate cell

Result will be the Enrolled ADM - Match 
Enrolled ADM to the Detailed SFPR Slide 40

Traditional tab



Special Education ADM on Detailed SFPR – Traditional

43

Can also be broken down by special education 
category by filtering on each category 

Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code 
and Inclusion Code, then sum the Adjusted Special Education CAT FTE and enter it (all 
decimals) into the appropriate cell

Result will be the Special Education ADM – Match to
Detailed SFPR on Slide 40

Traditional tab



Multiple ADMs on Detailed SFPR – COMM/STEM 
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Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code and Inclusion 
Code, then sum the Adjusted FTE or Adjusted Special Education FTE and enter it into the 
appropriate cell

Result will be the Enrolled ADM, Career Tech at JVSD or CTPD, and Special Education ADM

COMM STEM tab



Multiple ADMs on Detailed SFPR – JVSD
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ADJUSTED FTE * 100% 0.00 Community School Student attending a JVSD for CT

ADJUSTED FTE * 100% 0.00 Resident of District A, attending District B (not OE) then to a JVSD

ADJUSTED FTE * 100% 0.00 Direct Enrollment to a Non-Jointure JVSD (OE) 

ADJUSTED FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is within the jointure of 

both A and B 

ADJUSTED FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is not within the jointure of 

either A or B 

ADJUSTED FTE * 100% 0.00 Students educated at a jointure JVSD (not OE or CT)

Total 0.00

ADJUSTED SPECED CAT FTE * 100% 0.00 Community School Student attending a JVSD for CT

ADJUSTED SPECED CAT FTE * 100% 0.00 Resident of District A, attending District B (not via OE) then to a JVSD

ADJUSTED SPECED CAT FTE * 100% 0.00 Direct Enrollment to a Non-Jointure JVSD (OE) 

ADJUSTED SPECED CAT FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is within the jointure of 

both A and B 

ADJUSTED SPECED CAT FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is not within the jointure of 

either A or B 

ADJUSTED SPECED CAT FTE * 100% 0.00 Students educated at a jointure JVSD (not OE or CT)

Total 0.00

JVNR FULL

FULL

Table 6: JVSD - Enrolled ADM
Fund Pattern Inclusion Code

CTCS FULL

LEA in bold is the entity who will see the Fund Pattern Code and Inclusion Code combination for 

the row.   (Open Enrollment = OE, Contract Career Tech = CT, District of Residence = DOR) 

LEA in bold is the entity who will see the Fund Pattern Code and Inclusion Code combination for 

the row.   (Open Enrollment = OE, Contract Career Tech = CT, District of Residence = DOR) 

OJVR FULL

OPID FULL

CTCS FULL

JVNR FULL

OJVD FULL

RGJV

Sum the following 

Line a: Enrolled ADM 

Table 7: JVSD - Special Education ADM

ADJUSTED FTE Enrolled ADM

ADJUSTED FTE Enrolled ADM

Line b: Special Education ADM

RGJV FULL

Sum the following Fund Pattern Inclusion Code

OJVD FULL

OJVR FULL

OPID FULL

Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code and Inclusion Code, 
then sum the Adjusted FTE or Adjusted Special Education FTE and enter it into the appropriate cell

Result will be the Enrolled ADM and Special Education ADM

JVSD tab



Detailed SFPR – Additional Values 
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Filters added to the Archived 
FTE and CTE FTE reports and will 
match to most of these values



Filter Archived FTE Detail Report 
• Filter out (and keep them filtered out as additional filters are selected) 

• State Equivalent Grade Level = Preschool 

• Fund Pattern Codes = NONE and PART

• Set the below filters and remove before moving to the next bullet
• Filter Economic Disadvantagement = Y, then Sum Adjusted FTE 

• Filter English Learner Fund Category = 1, 2, 3 (separate or together), then Sum 
Adjusted FTE 

• Gifted - Sum Adjusted Gifted FTE, also, could filter grade levels K-8 and 9-12 

• Career Technical Education - Sum Enrolled ADM CTE FTE for total CTE FTE
• or filter Archived CTE FTE report by category (1,2,3,4,5) and sum Adjusted FTE

• Current Year Open Enrolled in – Filter on OPDD, then sum Adjusted FTE 

• These numbers can also be found on the FTES-009 and FTES-010 reports 
which will be reviewed on the next slides
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(FTES-009) FTE Subgroup Summary – Non-Transfers 

48

Columns K through Z will align with 
lines e-h on the Detailed SFPR  

Important Note: If your LEA has an FTES-010 
Transfers report, you must include 
“Out” values – See next slide



(FTES-010) FTE Subgroup Summary – Transfers 
Report includes students who are enrolled in Contract Career Tech or 
Special Education Cooperative Programs with FTEs transferred in or out 
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Other Results Codes Include: 
FT0241 Contract vocational transfers in
FT0243 Special Education transfers in 

Include “Out” FTEs from 
this report with those 
from prior slide



Combining the FTES-009 and FTES-010 FTEs
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FTES-009 Report 

FTES-010 Report 

Include only transfers out

1. Add together values in SPECED and CTE Columns from the FTES-009 
with the same columns on the FTES-010 transfers out only 

2. Match to values on Slide 46



What is Base Cost Enrolled ADM?
• Uses Enrolled ADM 

• Contains FTE data that is divided into specific categories

• Is the larger of the prior year or trailing 3-year average

• Can be verified using the Archived (FTES-008) Enrolled ADM FTE 
Summary – Prior three years data rows

• Archived (FTES-008) Enrolled ADM FTE Summary 
• Combination of three prior years data and the current year

• First three rows contain prior three years data 

• Last row contains current year data at the time data was pulled for 
the payment 
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Archived (FTES-008) Enrolled ADM FTE Summary 
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Contains 4 fiscal year’s 
data, we will use 2024 
to match to the Detailed 
SFPR and the prior three 
years for  Base Cost 
Enrolled ADM

Enrolled ADM 
for FY24 
January #2 
on slide 40

New Enrolled 
ADM column

The calculation for Total Enrolled ADM FTE in Column H for FY24 is
=I5+J5*0.5+K5+L5+M5+N5+O5*0.2+P5*0.2 for traditional districts, 
and =I5+J5*0.5+K5+L5+M5+N5 for JVSD, COMM, and STEM

Columns I-Q - Specific categories in current funding model



Base Cost Report  - Average or FY23? 

53

This district’s Base Cost 
uses the average since it’s 
larger than FY23 

If FY23 (b3) was higher than the 
average, it would have been used 
for Base Cost Enrolled ADM (b)

To calculate values b4-b9, use the Enrolled ADM average or FY23 
amount along with the formula from the FTES-008 (slide 52) 



Other Adjustments Report
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To match to the Archived FTE Detail, 
filter to each combination of CTXX 
and SPCO with Inclusion Codes FULL 
and NONE 

1. Filter Archived FTE Detail - CTXX/NONE and SPCO/NONE match to Positive FTEs

2. Filter Archived FTE Detail - CTXX/FULL and SPCO/FULL match to Negative FTEs



(FTES-010) FTE Subgroup Summary – Transfers 
Data for students who are enrolled in Contract Career Tech or Special Education 
Cooperative Programs with FTEs transferred in or out on this report matches to the 
Other Adjustments report on the prior slide
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Both result codes on this example are transfers  
out and will appear in the Negative section of 
the Other Adjustments Reports

CTE and Spec Ed are in opposite 
positions on FTES-010  versus the 
Other Adjustments Report  



Other Adjustments Report and Archived FTE Detail  
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Filter on Fund 
Pattern code 
PBDD on the 
FTE Detail 
Report 

1. Archived FTE Detail Report, Filter 
on Fund Pattern Code PSOP and PSOT 

District to district preschool open enrollment 

2. Filter on Inclusion Code NONE for 
Open Enrolled In – Positive FTEs  

3. Filter on Inclusion Code FULL for 
Open Enrolled Out – Negative FTEs 



Preschool Special Education Report - Trad
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Filter Archived FTE Detail 
Report to Grade level PS and 
Inclusion Code FULL, sum the 
Adjusted FTE

Filter by special education category as needed

Our DEMO file and 
example are short 
by 1.0 FTE (15.86) 



Educational Service Center Deduction – Trad
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This report shows special education 
PS students where both the ESC and 
district have reported to EMIS that 
they agree to transfer funds to the ESC

Filter traditional district’s archived 
FTE Detail report on PSET/FULL and 
PSIT/FULL, sum Adjusted FTE

Filter on traditional  district’s archived FTE Detail report 
on PSOT/NONE to see which students count here 



Preschool Special Education – ESC
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This report only shows special 
education PS students where 
both the ESC and district have 
reported to EMIS that they 
agree to automatically transfer 
funds to the ESC

Filter ESC Archived 
FTE Detail Report on 
Fund Pattern Codes 
PSET and  PSIT

This section contains one of many 
districts for this ESC. Add filters to 
Archived FTE Detail to drill down to 
individual students

District name(s) 
will appear here



Preschool Special Education – ESC , cont’d 
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Filter ESC Archived FTE Detail 
Report on Fund Pattern Code PSOT 
to see individual students

District names will appear on the report 



Quick Check
• Are you reviewing the Level 2 

versions of the FTE Reports prior to 
data being pulled for payments? 

• Are you reviewing the Archived FTE 
Reports to verify that all students 
are included as expected? 

• Are the reports being compared to 
payments to verify students are 
being funded correctly? 

Archived FTE Reports contain 
data that align with School 
Finance Payment Reports 
(SFPR). It’s important for EMIS 
staff to understand how EMIS 
data is being used in the 
funding process. 
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Resources
• Current EMIS Manual

• DEW Home > Topics > Data > EMIS > Documentation > EMIS Manual 

• Level 2 Report Explanations  
• DEW Home > Topics > Data > EMIS > Documentation > EMIS 

Validation and Report Explanations
• FTE Report Explanations (multiple) 

• School Payment Reports 
• Home > Finance & Funding > School Payment Reports

• Your ITC

• Your Area Coordinator
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Questions?
If you would like a certificate of attendance for this 

training, you must complete the below feedback 
form within 5 business days of this training

https://tinyurl.com/EA-District-Feedback

https://tinyurl.com/EA-District-Feedback
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